### SECTION 1 - INTRODUCTION

Basic Requirements ............................................................. 5

### SECTION 2 - SOFTWARE INSTALLATION

- USB Drive Installation .......................................................... 7
- Auto Detect Hardware Configuration ...................................... 9
- Load from a Saved File .......................................................... 9
- Create a New System ............................................................. 9
- File Menu ............................................................................ 9
- Open Configuration ............................................................. 9
- Export Spreadsheet .............................................................. 10
- Print Image .......................................................................... 10
- Print Legends ....................................................................... 10
- Export Legends .................................................................... 10
- Exit .................................................................................... 10
- View Menu .......................................................................... 11
- Normal View ........................................................................ 11
- Advanced View ..................................................................... 11
- Front View .......................................................................... 12
- Rear View ........................................................................... 13
- Tools Menu .......................................................................... 14
- Send Settings ........................................................................ 14
- Receive Settings .................................................................... 15
- Synchronise Time .................................................................. 16
- Clear Buffers ......................................................................... 17
- Restore System Settings to Default ......................................... 18
- About Configurator .............................................................. 18
- Diagnostics ........................................................................ 19
- LED Failure Alarm ............................................................... 20
- Add / Remove Cards ............................................................ 24

### SECTION 3 – AUTO DETECT HARDWARE

- Physical Size Tab ................................................................... 28
- Window Size .......................................................................... 28
- Windows Wide ........................................................................ 28
- Windows High ......................................................................... 28
- Pushbutton Module ............................................................... 29
- Window Configuration Tab ..................................................... 30
- Mixed Window Sizes ............................................................ 30
- Repeat Relays and Power Tab ................................................ 31
- No Repeat Relays ................................................................. 31
- Repeat Relays ........................................................................ 31
- Power Supply ......................................................................... 32
- External Power Supply ........................................................ 32
- Integral Power Supply .......................................................... 32
- Dual Redundant Power Supply ............................................. 32
- Alarm Inputs and Remote Pushbuttons Tab ........................... 33
- Alarm Inputs .......................................................................... 33
- Number of Remote Pushbuttons ........................................... 34
- Common Relays ...................................................................... 36
- Additional Options .............................................................. 36

### SECTION 5 – SAVED CONFIGURATIONS

- Open Configuration ............................................................. 39

### SECTION 6 – SYSTEM SETTINGS

- General Tab ........................................................................... 40
SECTION 7 – CHANNEL SETTINGS

Plant Name .................................................................................................................. 40
Description .................................................................................................................. 40
Tag No. ....................................................................................................................... 40
Serial No. .................................................................................................................... 40
Advanced View .......................................................................................................... 41
Ground fault Trip Level .............................................................................................. 41
LED Fault Detect ........................................................................................................ 41
Address Offset ........................................................................................................... 41
PSU Monitor Relays Normally De-energised ............................................................... 41
PSU Drive Front Display ............................................................................................. 41
Event Recording Tab ................................................................................................... 42
Sequence Events ......................................................................................................... 42
Input Events ............................................................................................................... 42
Output Events ............................................................................................................. 42
WR1 Tab ..................................................................................................................... 43
Relay 1 – 4 (Available on all standard systems) ......................................................... 43
Relay 1 to 8 (Relay 5 to 8 - Optional) ...................................................................... 43
WR2 Tab ..................................................................................................................... 44
Relay 1 to 12 (Relay 5 to 12 – Optional) ................................................................. 44
Group Relay ............................................................................................................... 45
Pushbutton .................................................................................................................. 45
Fault Relay .................................................................................................................. 46
Summary of Fault Relay function ............................................................................. 46
Coil Status ................................................................................................................... 47
Reflash Pulse Length .................................................................................................. 47
Local Pushbuttons Tab ............................................................................................... 48
Remote Pushbuttons Tab ........................................................................................... 48
Additional Pushbutton Groups ................................................................................... 49
Sleep Mode .................................................................................................................. 50
WR Relay Operation Whilst In Sleep Mode ............................................................. 52
Internal Horn Options Whilst In Sleep Mode .......................................................... 52
Inhibit ......................................................................................................................... 53
Internal Horns Tab ..................................................................................................... 54
Test Internal Horn Volume ....................................................................................... 55
Auto Acknowledge Tab .............................................................................................. 56
Auto Silence Tab ....................................................................................................... 57
Group Operations Tab ............................................................................................... 58
Comm’s Tab – Entry Level Comm’s ......................................................................... 60
Comm’s Tab – Standard Comm’s ............................................................................ 61
General Tab ................................................................................................................ 61
Serial Port Tabs .......................................................................................................... 63
Ethernet Port Tabs ..................................................................................................... 65
Mapping Tab ............................................................................................................... 68

SECTION 7 – CHANNEL SETTINGS ....................................................................... 69

Channel Tab ............................................................................................................... 69
Alarm Legend ............................................................................................................... 70
Show the Legends ....................................................................................................... 70
Print the Legends ........................................................................................................ 70
Export the Legends ..................................................................................................... 71
Manual Inhibit ............................................................................................................ 71
Inhibit Input ................................................................................................................ 71
Group 1 to Group 8 ................................................................................................... 71
Auto Shelving ............................................................................................................. 72
Event Recording ........................................................................................................ 72
Colour ......................................................................................................................... 72
Input Tab ..................................................................................................................... 73
Contact Type ............................................................................................................. 73
Delay Timers ............................................................................................................... 73
Abnormal Delay (ms) ............................................................................................... 73
Normal Delay (ms) .......................................................................................................... 73
Field Contact Voltage................................................................................................... 74
Contact Fault Monitoring ............................................................................................ 75
Remote and Local inputs .............................................................................................. 76
Relay Tab ....................................................................................................................... 77
Coil Status ..................................................................................................................... 77
Relay Function .............................................................................................................. 77
Abnormal Delay .......................................................................................................... 77
Normal Delay ............................................................................................................... 78

Alarm Sequences .................................................................................................... 79
ISA A – Automatic Reset – Lock In ........................................................................... 82
ISA A-4 – Automatic Reset – Non Lock In ................................................................. 84
ISA A-4-5 – Automatic Reset – No Flashing ............................................................... 85
ISA A-4-5-6 – Status .................................................................................................. 86
ISA A-5 – Automatic Reset – No Flash ...................................................................... 88
ISA M – Manual Reset – Lock In ............................................................................... 89
ISA M-1-2 – Manual Reset – Silence Pushbutton Interlock ....................................... 90
ISA R – Ringback ....................................................................................................... 91
ISA F1A-1 – Automatic Reset First Up ....................................................................... 92
ISA F2M-1 – Manual Reset First Up .......................................................................... 93
ISA F2A-1 – Automatic Reset First Up ...................................................................... 94
ISA F3A – Automatic Reset First Up ........................................................................ 95
ISA F3A-3 – First Out Reset Interlock ...................................................................... 97
ISA F3M – Manual Reset First Out ........................................................................... 97
ISA F3M-1-2 – Manual Reset First Out with Silence Interlock .................................. 97
Pushbutton Groups ..................................................................................................... 98
Global Pushbutton Groups ......................................................................................... 98
Multiple Pushbutton Groups ...................................................................................... 99
Alarm Groups ............................................................................................................ 100
Horn Groups ............................................................................................................. 101

SECTION 8 - FACTORY DEFAULT SETTINGS ........................................... 102
Global Systems Setting Default Settings ................................................................. 102
Individual Channel Default Settings ....................................................................... 107
SECTION 1 - INTRODUCTION

The P725B Configuration software allows the user to create, edit, read or write configurations via USB connected to USB port behind the Pushbutton Module, or under the unit on units without the pushbutton module.

This allows the user to store a specific configuration on a local PC as a backup or allows them to pre load the software so that they can write the configuration to a P725B on site at a later date. The user can also read existing configuration settings direct from a P725B system so that the settings can be viewed, edited or saved.

Eaton's MTL product line recommend that a back up copy of any P725B system is always made for security purposes.

Basic Requirements
Before installing the RTK Configuration software please check that your PC meets the following min requirements

IBM Compatible PC with a min of 600MHz processor

At least 256MB of ram memory

At least 2GB hard drive

800 x 600 SVGA or higher resolution monitor supported by Microsoft Windows

A Printer supported by Microsoft Windows

An Operating System Installed on your computer:- Microsoft Windows NT3, Windows 2000, Windows XP or Windows 7
SECTION 2 - SOFTWARE INSTALLATION

The configuration program and associated drivers are supplied on a CD along with a USB cable. Before connecting the cable to the Annunciator please ensure the software has been loaded onto a local PC or laptop.

First place the CD into the associated Drive and locate the file titled RTKConfiguratorInstaller.exe. If you require desktop and start menu short cuts please tick the option boxes as shown below.

![Software Installation Screen](image)

After the program has been installed, please ensure the Annunciator is powered and then the pushbutton faceplate can be removed to expose the USB port as described below:

A small flat blade screwdriver can be used to gently ease the top edge of the pushbutton face plate out which allows access the USB programming port which can be used to:

1. Upload a configuration from an existing 725B
2. Download a configuration to the 725B
3. View diagnostic data whilst fault finding.

![USB Port](image)
USB Drive Installation

With the Annunciator powered plug the USB cable into the USB Port and the other end of the cable into the PC or laptop.

The “Found New Hardware” Balloon will appear. Click on the balloon to launch the New Hardware Wizard. Select “Install from a specific location”

Click next and note the root path shown next to the browse control button in the details below. If this path is not visible use browse to locate the following: - “C:\Program Files\RTK Instruments\Configurator\drivers”

During the driver install, an information box appears. Please select the “Continue Anyway” button to proceed.
The associated drivers should now be fully loaded and ready to use.

Start the configurator by clicking the RTK icon which will appear on your desktop.

The following screen appears once the software has been initialised which invites the user to select the hardware type to be configured as shown below.

Select the 725B radio button using a left mouse click and once this has been selected the user is prompted to select one of three options:-
Auto Detect Hardware Configuration.
If a 725B System is connected to the associated PC via the USB programming port and communication has been established the software will be able to read the configuration data direct from the annunciator system.

Load from a Saved File
If a 725B configuration file has been previously saved the user can load the data to the configuration software using “Load from a saved file” and normal Microsoft Windows ® navigation techniques to select the stored data.

Note: This doesn’t include any port mapping data, this must be loaded separately from the mapping spreadsheet.

Create a New System
This menu is greyed out and the feature is only used during the manufacturing process to define the system structure.

After the software has loaded the user is able to access the following Menu’s

File Menu
The File Menu provides access to the following:-.

Open Configuration
Selecting the File Menu followed by “Open Configuration” allows a previously saved configuration file to be uploaded. Standard Microsoft Windows ® navigation techniques allow the user to locate the file and a left mouse click on the “Open” command button uploads the configuration for review or modification.
Save Configuration (*.rtk)
Once the user has created a “new” or modified an “existing” configuration the associated file can be saved using the File Menu followed by “Save Configuration”. Standard Microsoft Windows ® navigation techniques can be used to define the location and after a file name has been defined a left mouse click on the “Save” command button completes the process.

Export Spreadsheet
Once a configuration has been defined the user is able to export all of the configuration data to a Microsoft Excel spreadsheet for record purposes.

Print Image
The configuration software provides access to front or rear views of the annunciator and these views can be printed if required. Once “Print Image” has been selected additional sub menus are available to allow selection of printer type, page size, orientation etc.

Print Legends
The configuration software allows the user to define the alarm legends for each channel as described later in this manual.

Once the Legend details have been entered into the software the user can

1. Print a paper copy of the legends for record purposes
2. Use acetate film in a laser printer to print the alarm legends which can be fitted to the alarm annunciator as required.

Export Legends
As an alternative the user can save an electronic copy of the legend details using the “Export Legends” menu and standard Microsoft Windows ® navigation techniques to save the file in Microsoft Excel format.

Exit
The “Exit” Menu allows the user to quit the application but please ensure that you save any configuration changes before selecting exit.
View Menu
The following options are available under the “View” menu

Normal View
In the “Normal View” the number of groups displayed is limited to 8. A max of 32 Groups are available within the 725B for use as Horn, First Up or Common Alarm groups and the additional groups are accessed under the advanced view.

Advanced View
In more complex applications the “Advanced View” allows full access to all 32 groups and other advanced features within the annunciator as shown in the example below.
**Show Legends**
The alarm text and colour of each alarm way can be displayed within the configuration software by selecting the “View” menu followed by the “Show Legends” as shown below. Channel numbers are used as default to identify each alarm way and the nameplate colour is set to red however the user is able to edit the text and colour of each channel to match the annunciator fascia and to aid navigation within the software.

As a default the window colour is Red and the channel number is used to identify each alarm way. The user is able to edit the alarm text and colour of each channel to provide a clearer view and to aid navigation within the software.

**Front View**
The front view of the alarm Annunciator is displayed by default to simplify configuration. This view is defined under the “View” menu followed by “Front View” as shown below.
Rear View

As an alternative the rear view of the alarm annunciator can be displayed showing details of the associated cells.

This view is accessed using the “View” menu followed by “Rear View” as shown below.
Tools Menu

The following options are available under the “Tools” menu

Send Settings

Selecting the “Send Settings” menu allows the user to transmit the configuration to the associated 725B Annunciator. Once selected the Communications Port will be displayed and the “Send” command key should be pressed using a left mouse click.

If an annunciator is not detected the following error message will be displayed.

If communication is established a status bar is used to provide a visual indication of progress as shown below.
Receive Settings
Selecting the “Receive Settings” menu allows the user to read the configuration from the associated 725B Annunciator. Once selected the “Read” command key should be pressed using a left mouse click.

If an annunciator is not detected the following error message will be displayed.

Once communication has been established a status bar is used to provide a visual indication of progress as shown below.
Synchronise Time

725B Systems are available with a Sequential Event Recording option which provides Time Stamping of each alarm to a minimum of 1ms resolution. The time stored within the 725B system can be synchronised to the PC by selecting “Tools” and “Synchronise Time” menu.

Once selected the user is presented with the following screen

If the user wishes to proceed a left mouse click from the “Synchronised” command button will commence transmission between the PC and the Annunciator.

A status bar provides indication of transmission, and once it has reached 100% the user can close the associated window.
Clear Buffers

**CAUTION**
The user must be aware that this command erases ALL historical alarm data therefore this command should be used with caution.

Event Buffers are provided within the 725B Annunciator to store alarm data and time stamp information for future analysis however during the installation and commissioning phase these buffers can contain a large number of false alarm data. Selecting the “Tools” and “Clear Buffers” menus provides access to the following screen.

Selecting the “Clear” command button using a left mouse click will erase all of the stored data and a status bar is used to indication progress.

Once the “Status Bar” has reached 100% the window can be closed.
Restore System Settings to Default
If the software has been used to trial configurations the unit can be returned to factory default settings using the “Tools” menu followed by “Restore System Settings to Default” as shown below.

CAUTION
This setting will automatically convert ALL of the Systems options to the factory default setting and therefore it should only be used with caution. Full details of default settings are provided in the rear of this manual.

About Configurator
This allows the user to view the revision number of the configuration software
Diagnostics
All units are supplied with an inbuilt diagnostic facility which allows the user to connect the supplied USB cable to a PC equipped with the configuration software to provide dynamic diagnostic feedback.

Once selected the following screen will appear

If no errors are detected the diagnostic window will be blank as shown above

**Example 1**
In the typical example shown below the signal supply voltage has not been detected, typically as a result of a blown fuse, and the error message indicates that the user should check the field contact supply.
Example 2
In the example shown below a watchdog alarm is present as the system has detected an error with an alarm card, (address 2), which has not been detected.

![Example 2 Image]

Example 3
In the example shown below if a window suffers a total loss of LED’s the watchdog LED located on the pushbutton module will flash and software diagnostics can be used to provide indication as typically shown below.

![Example 3 Image]

A common relay can be set to operate when LED failure has been detected if required.

Types of errors
The following error codes / messages are provided:

- **Field Contact Supply**
  
  Verify that the Signal Supply voltage is present by measuring the voltage and / or checking the protection fuse.

- **Watchdog**
  
  The Alarm Annunciator is equipped with a number of diagnostic features to assist the user during fault conditions. The Watchdog Relay can be programmed to monitor All Faults, Field Contact Supply, System Faults, Communication Faults, Power Faults, Card Faults, etc. as detailed in the Configuration Software Manual.

- **Card Not Signed On**
The Annunciator is supplied with a defined architecture and if a card fails to respond to its start-up routine this error code will be generated.

- **Remote Communication**

  The Communication Port is monitored and loss of data will result in the above error code

- **Real Time Clock**

  The Communication Card is provided with battery backup to maintain the Real Time Clock this error code indicates a failed battery or loss of RTC function

- **System Structure**

  The Annunciator is supplied with a defined architecture and if a fault occurs within the structure i.e. A Card is removed the system recognises the change in structure and flags the above error message.

- **Internal Power Supply**

  When using integral power supplies each PSU is monitored and if power is isolated and a fault develops the above error code would occur.

- **Memory Fault**

  The Alarm Annunciator stores data and in the event of failure the above error code occurs.

- **LED failure**

  Each channel within the annunciator is equipped with plug in LED assemblies which provide the window illumination. If a window suffers a total loss of LED’s the watchdog LED located on the pushbutton module will flash and software diagnostics can be used to provide indication as typically shown below
Comms Diagnostics

Units supplied with Standard and Enhanced Comms are supplied with an inbuilt diagnostic facility which allows the user to connect the supplied USB cable to a PC equipped with the configuration software to provide dynamic diagnostic feedback of the comms port status.

Once selected the following screen will appear

If no errors are detected the diagnostic window will be blank or show port inactive as shown above
**Example**

In the example shown below a timeout error is present as the port has timed out.

![Example Image](image_url)

**Types of errors**

The following error codes / messages are provided

- **Port Inactive**
  
  Port is set to No protocol is not active

- **Timeout Error**
  
  Slave Port has timed out as it has not received a valid message for the selected timeout period

- **No Response**
  
  Master Port has had no response from slave, for the number of retry’s selected.

- **Illegal Function Response**
  
  Port has received an invalid function/ID response

- **Invalid Data Address Response**
  
  Port has received an invalid data range requested

- **Invalid Data Response**
  
  Port has received invalid data that is not valid for the operation requested
• Buffer Full Warning

Port Buffer has reached its warning level. I.e. if level set to 70% this error will appear when the buffer exceeds this level.

• Ethernet Disconnected

For Ethernet ports this error indicates that no connection has been made.

• Activity Timeout

Slave Port has reached its activity timeout as it has not received a valid message for the selected activity timeout period. This forces the port to go inactive.

Add / Remove Cards

The user is able to use this feature to remove specific cards in software by selecting the “View” Menu followed by rear view and then a right mouse click over the rear terminal view of the specific card allows the user to select Remove Card as shown below.

Once a card has been removed in software the associated terminal view changes to yellow from green to indicate that the card is no longer present.

If the user wishes to complete the removal of the card from software the “Tools” menu provides access to the Add/Remove Cards download function as shown below
Once selected the user will be prompted to press the Add/Remove control button to confirm that they wish to proceed.

Once the control button has been pressed the download status is provided to confirm data transfer or an error flag will appear if problems occur.

SECTION 3 – AUTO DETECT HARDWARE.

The user is able to “Auto Detect Hardware Configuration” after loading the software and connecting the USB cable to the associated ports.

Once the application has been launched the user can select the 725B radio button using a left mouse click.

After pressing the “Confirm” button the user is prompted to select one of three options:

To upload the setting from a 725B select “Auto Detect Hardware Configuration”
Once the confirm radio button has been pressed using a left mouse click the user will be prompted with a Detect radio button as shown below.

If an annunciator is not detected the following error message will be displayed.

If any conflicts are found during the detection process an error message will provide diagnostic details to assist the user with fault finding.
In this example the card set to address 2 has not been successfully detected and the auto detect halts until the user resolves the issue.

If a 725B System is connected to the associated PC and communication has been established the software will be able to read the configuration data direct from the annunciator system.

Once upload is complete the Annunciator graphic should match the supplied instrument and the associated fields will indicate all of the configured features.

*Please refer to Section 6 & 7 for details of configurable options*
SECTION 4– CREATE A NEW SYSTEM

This section is used by the factory to define the structure of the system prior to delivery

Physical Size Tab

A drop-down menu is provided to the right of each of the following three fields to allow the cabinet to be defined. The graphical view of the Annunciator is dynamically updated as selections are made.

Window Size

The window size defines the number of windows available in each 60mm x 60mm cell in accordance with the following chart.

<table>
<thead>
<tr>
<th>Window Style</th>
<th>Window Size (W x H)</th>
<th>Alarms per Cell</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large</td>
<td>60mm x 60mm</td>
<td>1</td>
</tr>
<tr>
<td>Medium</td>
<td>60mm x 30mm</td>
<td>2</td>
</tr>
<tr>
<td>Small</td>
<td>30mm x 30mm</td>
<td>4</td>
</tr>
</tbody>
</table>

Windows Wide

Once a window size has been assigned the user is able to select the total number of windows wide within the range defined below.

<table>
<thead>
<tr>
<th>Window Style</th>
<th>WINDOWS WIDE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large</td>
<td>Selectable from 1 to 16 Wide</td>
</tr>
<tr>
<td>Medium</td>
<td>Selectable from 1 to 16 Wide</td>
</tr>
<tr>
<td>Small</td>
<td>Selectable in pairs from 2, 4, 6, 8, 10, 12, 14 to 16 Wide</td>
</tr>
</tbody>
</table>

Windows High

Once a window size has been assigned the user is able to select the total number of windows high within the range defined below.

<table>
<thead>
<tr>
<th>Window Style</th>
<th>WINDOWS HIGH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large</td>
<td>Selectable from 1 to 16 Wide</td>
</tr>
<tr>
<td>Medium</td>
<td>Selectable from 1 to 16 Wide</td>
</tr>
<tr>
<td>Small</td>
<td>Selectable in pairs from 2, 4, 6, 8, 10, 12, 14 to 16 Wide</td>
</tr>
</tbody>
</table>
Pushbutton Module
Standard 725B Systems are supplied with an integral pushbutton / programming module located in the bottom right hand corner of the Annunciator when viewed from the front as typically shown below.

To enable the integral pushbutton function the drop down menu to the right of the “Pushbutton Module” field needs to be selected to Integral.

In standard systems the Pushbutton module is located in the bottom right hand corner as shown above.

Once the user has configured the basic unit a left mouse click on the “Next” control button navigates to the “Window Configuration” screen. This screen is only required in applications that use mixed window sizes.

The “Next” control button can be used to proceed with configuration.
Window Configuration Tab
This section is only used in systems supplied with mixed window sizes on standard system the user can bypass this screen using the “Next” control button.

Mixed Window Sizes
The “Window Configuration” Tab allows the user to define the window style of each cell. A left mouse click on one of the four cells shown under the tab automatically copies the style. The selection is confirmed when a red border appears around the icon as typically shown below. A left mouse click into any cell in the annunciator graphic pastes the style.

The “Next” control button can be used to proceed with configuration.
Repeat Relays and Power Tab
This tab provides access to the fields associated with optional repeat relay per channel facilities and Integral Power Supplies.

No Repeat Relays
On standard systems their individual channel repeat relays are not fitted and therefore the drop down menu is set to “No Repeat Relays”.

Repeat Relays
As an option each channel can be supplied with a dedicated repeat relay facility to provide an isolated output for use with 3rd party devices.

In these applications the drop-down menu needs to be set to “Single Repeat Relay Per Channel” as shown below.

Dual Repeat Relays
As an option each channel can be supplied with dual repeat relays to provide two isolated outputs for use with 3rd party devices.

In these applications the drop-down menu needs to be set to “Dual Repeat Relays Per Channel” as shown below.
Power Supply
725B Systems operate on a logic voltage of 24VDC and this can be supplied via External or Internal Power Supplies.

External Power Supply
In Systems using an externally derived 24VDC the drop down menu under the “Power Supply Field” needs to set to be “External Power Supply” as shown below.

Integral Power Supply
If the annunciator system is directly powered from either 72 to 144VDC or 85 to 264VAC integral universal power supplies are used to convert to 24VDC and the drop down menu needs to be set to “Integral Power Supply”.

Dual Redundant Power Supply
If Integral Power Supply is selected the Dual Redundant option becomes available which uses 2 off Integral PSU per power section to provide redundancy.

SMR
If Integral Power Supply is selected the SMR option becomes available which provides additional relays that monitor the PSU and indicates a PSU failure.

The “Next” control button can be used to proceed with configuration.
Alarm Inputs and Remote Pushbuttons Tab

Alarm Inputs
Standard systems use optically isolated digital inputs fed via a volt-free contact or externally powered device. In these applications the standard input radio button is checked as shown below.

If the annunciator has been supplied with the differential input option, which provides fully isolated inputs per alarm channel, the Differential input radio button is checked.

The field contact voltage should be set to either DC or AC – in the example above the standard version uses +24VDC to trigger the signal inputs.
Number of Remote Pushbuttons

On standard 725B Systems 6 control Inputs are provided in the system for use with external control inputs typically used when remote pushbuttons or remote Inhibit switches are required.

Example 1

<table>
<thead>
<tr>
<th>Function Required</th>
<th>Number of Remote Inputs Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lamp Test</td>
<td>1</td>
</tr>
<tr>
<td>Acknowledge</td>
<td>1</td>
</tr>
<tr>
<td>Reset</td>
<td>1</td>
</tr>
<tr>
<td>System Test</td>
<td>1</td>
</tr>
<tr>
<td>Silence</td>
<td>1</td>
</tr>
<tr>
<td>1st Reset</td>
<td>1</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>6</strong></td>
</tr>
</tbody>
</table>

The control inputs are provided on either the first 2 alarm cards in the system i.e. each card will provide 4 digital inputs for the alarms plus 3 control inputs for the pushbutton functions. Or on a separate remote pushbutton card which provides 6 remote pushbuttons.

The “Number of Remote Pushbuttons” Field should be set to 6 using the navigation buttons as shown below.

Example 2: Remote Pushbuttons plus Inhibit Group Inputs

<table>
<thead>
<tr>
<th>Function Required</th>
<th>Number of Remote Inputs Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lamp Test</td>
<td>1</td>
</tr>
<tr>
<td>Silence</td>
<td>1</td>
</tr>
<tr>
<td>Acknowledge</td>
<td>1</td>
</tr>
<tr>
<td>Reset</td>
<td>1</td>
</tr>
<tr>
<td>Inhibit Group 1</td>
<td>1</td>
</tr>
<tr>
<td>Inhibit Group 2</td>
<td>1</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>6</strong></td>
</tr>
</tbody>
</table>

The control inputs are provided on the first 2 alarm cards in the system i.e. each card will provide 4 digital inputs for the alarms plus 3 control inputs for the pushbutton / inhibit functions. Or on a separate remote pushbutton card which provides 6 remote pushbuttons.
Example 3: Remote Pushbuttons **plus** Sleep Mode Input

<table>
<thead>
<tr>
<th>Function Required</th>
<th>Number of Remote Inputs Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Test</td>
<td>1</td>
</tr>
<tr>
<td>Acknowledge</td>
<td>1</td>
</tr>
<tr>
<td>1st Reset</td>
<td>1</td>
</tr>
<tr>
<td>Sleep Mode</td>
<td>1</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>4</strong></td>
</tr>
</tbody>
</table>

The control inputs are provided on the first 2 alarm cards in the system i.e. each card will provide 4 digital inputs for the alarms plus 3 control inputs for the pushbutton / sleep mode functions. Or on a separate remote pushbutton card which provides 6 remote pushbuttons.

The “Number of Remote Pushbuttons” Field should be set to 6.

Example 4: 2 x Remote Pushbutton Groups plus 2 x Group Inhibit

<table>
<thead>
<tr>
<th>Function Required</th>
<th>Number of Remote Inputs Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pushbutton Group 1</strong></td>
<td></td>
</tr>
<tr>
<td>System Test</td>
<td>1</td>
</tr>
<tr>
<td>Acknowledge</td>
<td>1</td>
</tr>
<tr>
<td>1st Reset</td>
<td>1</td>
</tr>
<tr>
<td><strong>Pushbutton Group 2</strong></td>
<td></td>
</tr>
<tr>
<td>System Test</td>
<td>1</td>
</tr>
<tr>
<td>Acknowledge</td>
<td>1</td>
</tr>
<tr>
<td>1st Reset</td>
<td>1</td>
</tr>
<tr>
<td><strong>Inhibit</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Inhibit Group 1</strong></td>
<td>1</td>
</tr>
<tr>
<td><strong>Inhibit Group 2</strong></td>
<td>1</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>8</strong></td>
</tr>
</tbody>
</table>

The control inputs are provided on the first 3 alarm cards in the system i.e. each card will provide 4 digital inputs for the alarms plus 3 control inputs for the pushbutton / inhibit functions. Or on 2 separate remote pushbutton card which provides 6 remote pushbuttons.

The “Number of Remote Pushbuttons” Field should be set to 9.

**Error Message**

If the number of Remote Pushbutton Inputs selected exceeds the number of Alarm cards available a warning message appears to advise the user that the configuration is not possible.
Common Relays

A four channel common relay card is provided as standard and each relay can be assigned to a group, fault or pushbutton.

**Example 1:-** 1 x Horn, 2 x Common Alarm and 1 x Fault Relay

<table>
<thead>
<tr>
<th>Function Required</th>
<th>Number of Common Relays</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horn Relay</td>
<td>1</td>
</tr>
<tr>
<td>Group 1 Relay</td>
<td>1</td>
</tr>
<tr>
<td>Group 2 Relay</td>
<td>1</td>
</tr>
<tr>
<td>System Fault Relay</td>
<td>1</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>4</strong></td>
</tr>
</tbody>
</table>

In this application the 4 common relays provided as standard are sufficient.

The “Number of Common Relays” Field should be set to 4 as shown below.

**Example 2:-** 2 x Horn, 3 x Common Alarm and 1 x Fault Relay

<table>
<thead>
<tr>
<th>Function Required</th>
<th>Number of Common Relays</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horn Group 1 Relay</td>
<td>1</td>
</tr>
<tr>
<td>Horn Group 2 Relay</td>
<td>1</td>
</tr>
<tr>
<td>Group 1 Relay</td>
<td>1</td>
</tr>
<tr>
<td>Group 2 Relay</td>
<td>1</td>
</tr>
<tr>
<td>Group 3 Relay</td>
<td>1</td>
</tr>
<tr>
<td>System Fault Relay</td>
<td>1</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>6</strong></td>
</tr>
</tbody>
</table>

In this application the 4 common relays provided as standard are insufficient and an additional 4 channel common relay card would be provided.
Example 3- 2 x Horn, 3 x Common Alarm, 1 x Acknowledge Output and 1 x Fault Relay

<table>
<thead>
<tr>
<th>Function Required</th>
<th>Number of Common Relays</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horn Group 1 Relay</td>
<td>1</td>
</tr>
<tr>
<td>Horn Group 2 Relay</td>
<td>1</td>
</tr>
<tr>
<td>Group 1 Relay</td>
<td>1</td>
</tr>
<tr>
<td>Group 2 Relay</td>
<td>1</td>
</tr>
<tr>
<td>Group 3 Relay</td>
<td>1</td>
</tr>
<tr>
<td>Ack PB Follower</td>
<td>1</td>
</tr>
<tr>
<td>System Fault Relay</td>
<td>1</td>
</tr>
<tr>
<td>Total</td>
<td>7</td>
</tr>
</tbody>
</table>

In this application the 4 common relays provided as standard are insufficient and an additional 4 channel common relay card would be provided.

The “Number of Common Relays” Field should be set to 8.

Error Message
If the number of Relays selected exceeds the space available a warning message appears indicating how many relays cannot be fitted.

The “Next” control button can be used to proceed with configuration.
**Additional Options**

The following features are available as an option:

1. Entry Level Communication and required protocol
2. Standard Communication and required protocol
3. Enhanced Communications and required protocol
4. Time Stamping
5. Tropicalisation
6. Any additional comments

The “Next” control button can be used to proceed with configuration.

The basic configuration of the system is now complete and the user is able to save the basic configuration for use as a master template.

**Saved Configuration**

The File and “Save Configuration” menu provide normal Microsoft Windows navigation for file saving.

*Once a file has been saved you will not need to define any of the preceding settings again.*
SECTION 5– SAVED CONFIGURATIONS

Open Configuration
The File and “Open Configuration” menu provides normal Microsoft Windows navigation allowing a previously saved configuration to be opened from the stored location.

Once a previous configuration file has been opened the user can review configuration settings as detailed in Section 6 & 7.
SECTION 6 – SYSTEM SETTINGS

General Tab
The fields listed under the “General” tab allow the user to uniquely identify each Alarm Annunciator System to aid with the storage and retrieval of configuration data.

The user can update any of the fields within the software but the changes will only be saved after the "Confirm Settings" control button is pressed using a left mouse click.

Plant Name
In the example shown above the annunciator is located in Eaton Electric Ltd.

Description
This field is used to identify the specific plant area or annunciator function within the plant..

Tag No.
This field allow a Customer assigned number to be used to identify a unique alarm annunciator.

Serial No.
A serial number is automatically provided once the software is communicating with the alarm annunciator.
Advanced View

To access the additional features the user must select the “View” menu followed by “Advanced View”.

![Configuration options](image)

- **Ground fault Trip Level**
  On units supplied with the ground detect option the user can select the trip level for the fault to be triggered.

- **LED Fault Detect**
  This field allows a Customer to Disable and Enable the LED fault detection functionality.

- **Address Offset**
  On units that can be joined together the start address (Cell number) can be offset.

- **PSU Monitor Relays Normally De-energised**
  On units supplied with the SMR card the relays can be changed to Normally DE-Energised instead of the default Normally Energised state.

- **PSU Drive Front Display**
  On units supplied with the optional Power Fail window, the LED drive can be enabled or Disabled to drive the window.
**Event Recording Tab**

If the Time Stamping option of the 725B has been supplied the user can enable or disable the type of events to record – using the following fields.

**Sequence Events**

The user is able to “Disable” the Sequence Events feature or enable recording of Input or Output Events”.

**Input Events**

The user is able to “Enable” the Input Events feature to provide historical data indicating the time and date inputs occur and return to normal.

**Output Events**

The user is able to “Enable” the Output Events feature to provide historical data indicating additional alarm sequence information for example “first-up”, subsequent.

**Individual Channel Enable**

In addition to the global SOE “enable” setting detailed above the user can enable or disable Event Recording on a per channel basis using the tick box indicated below under the channel tab.

The user is able to update any field within the software but the changes will not take effect until the “Confirm Settings” control button is pressed using a left mouse click.
WR1 Tab
The WR1 Tab, (Watchdog / Relay), allows the user to assign any of the common relays for use as a Group, Pushbutton Follower or Fault Relays.

On standard 725B systems one 4 channel relay card is used to provide common relays.

Relay 1 – 4 (Available on all standard systems)
A drop-down menu is accessed using a left mouse click on the control button associated with each Relay. This menu is used to define whether the Relay operates as a Group, Pushbutton Follower or Fault Relays.

In some applications users require more than 4 common relays, in these instances a single or multiple 4 channel relay cards can be used to expand the system.

The WR1 Tab provides configuration for a maximum of 8 Relays.

Relay 1 to 8 (Relay 5 to 8 - Optional)
In the example below one additional 4 Channel Relay card has been fitted, providing 8 Relays in total.

If more than 8 Relays are installed two WR* Tabs will be available to configure Relays 9 onwards, as shown in the following typical examples.
WR2 Tab

Relay 1 to 12 (Relay 5 to 12 – Optional)
In the example below a total of 12 Relays are fitted with Relay 1 to 8 being configured under the WR1 Tab and the remaining Relays being configured under the WR2 Tab.

This pattern continues as shown below, (4 Relays per additional card),

<table>
<thead>
<tr>
<th>No of Common Relays</th>
<th>WR* Tab No</th>
<th>Relay No</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>WR1</td>
<td>1 to 4</td>
</tr>
<tr>
<td>8</td>
<td>WR1</td>
<td>1 to 4</td>
</tr>
<tr>
<td>12</td>
<td>WR1</td>
<td>1 to 4</td>
</tr>
<tr>
<td>16</td>
<td>WR1</td>
<td>1 to 4</td>
</tr>
<tr>
<td></td>
<td>WR2</td>
<td>1 to 4</td>
</tr>
<tr>
<td></td>
<td>WR1</td>
<td>1 to 4</td>
</tr>
<tr>
<td></td>
<td>WR2</td>
<td>1 to 4</td>
</tr>
<tr>
<td>ETC</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Group Relay.
Each Channel within the Annunciator can be assigned to a single or multiple Groups. These Groups can be software linked to any of the common relays to provide contact outputs for use with 3rd Party devices.

In the example below Relay 1 is being assigned to Group 1 and a left mouse click would complete the selection.

Once the Relay has been assigned the “Control Button” is automatically updated to indicate its function. I.E. Relay 3 has been assigned to Group 4 and Relay 4 has been assigned as a System Fault Relay.

Pushbutton
Any one of the Common Relays can be assigned to any of the Pushbutton functions shown below. In this example Relay 1 has been assigned as a Silence Pushbutton Follower and each time the Silence Pushbutton is activated on the Annunciator the contacts on Relay 1 will change state.
**Fault Relay.**
Any of the Common Relays can be assigned to a diagnostic fault condition to provide a contact output in the event of logic, signal supply, communication or system failure. In the example below Relay 4 has been assigned as System Fault Relay.

![Image of relay diagram]

**Summary of Fault Relay function**

**Field Contact**
Monitors the Field Contact voltage

**System**
Monitors the complete System.

**Comm’s**
Monitors the Communication link

**Power**
Monitors the 24VDC Logic power

**Card**
Monitors individual Alarm Cards

**Ground**
For use with systems fitted with ground fault detection to indicate a ground fault has occurred.

**LED**
Provides an output if any of the LED’s used to illuminate individual windows becomes faulty.

Please note:- The system scans the LED state on an hourly cycle or during power up.

**GPS**
For use with systems provided with GPS clock sync to indicate a failure
**Printer**
For use with systems provided with time stamping and printers to indicate that a printer failure has occurred.

**Real Time Clock**
Used to indicate a failure in RTC time sync.

As well as being able to set the function of each relay the user can set the non alarm coil state of each relay as follows:-

**Coil Status**
The Coil Status of each Relay can be set using the drop-down menu. In the example below Relay 1 has been set to Normally De-Energised.

**Reflash Pulse Length**
Common Alarm Relays change state on alarm and remain active until the alarm has been cleared.

When multiple alarms appear in the same group “Reflash” is used which allows the Relay to drop out and re-alarm each time a new alarm occurs within the same group.

As the Common Alarm Relay Contact are used with 3rd Party devices, the “Reflash” pulse length can be set to match the requirements of the device.

*The user is able to update any field within the software but the changes will not take effect until the “Confirm Settings” control button is pressed using a left mouse click*
Local Pushbuttons Tab
In some applications customers prefer to disable selective Integral Pushbutton functions in preference to Remote Pushbutton control.

The user is therefore able to enable any of the 6 Pushbutton functions using the Tick-Boxes shown below.

Remote Pushbuttons Tab
In certain applications remote pushbuttons inputs are required.

All 725B Annunciators are able to accept a minimum of 6 x external control inputs. The first alarm card in the system can be wired to remote Pushbuttons, Sleep or Inhibit Group Switches as required.

In applications that require more than 6 x inputs each additional Alarm Card can be provided with 3 x additional Inputs as required or additional remote pushbutton cards can be added

A drop-down menu allows any Pushbutton function to be assigned to a Card capable of accepting hardwired control inputs.

In the example below Lamp Test has been assigned to Card 1 Pushbutton input 1. Please note: Pushbutton 2 to 6 are greyed out as they have already been assigned to other Pushbutton functions.
### Additional Pushbutton Groups

In more complex applications the user may prefer to use more than one Pushbutton Group within the Annunciator. For example: Groups of alarms associated with specific plant areas can be controlled by unique externally mounted Pushbuttons.

To access the additional pushbutton groups the user must select the “View” menu followed by “Advanced View” which will allow pushbutton groups 1 to 8 to be configured as shown below.

![Pushbutton Group Configuration](image)

In the example shown 2 remote pushbutton cards each equipped with 6 x remote pushbutton inputs providing 12 x inputs in total.
Sleep Mode

Sleep mode is typically used in sub station applications where the visual and audible outputs are disabled during unmanned periods to reduce the drain on the associated station batteries and to prevent noise pollution.

Whilst in sleep mode the logic of the annunciator will continue to react in the normal way including the operation of common alarm relays, watchdog relays and optional signal duplicating relays, only the drive signals to the LED’s and audibles are disabled. A remote hardwired control input is required to activate Sleep Mode and this input needs to be wired to an alarm card fitted with pushbutton inputs. The Sleep function can be assigned to any available pushbutton input. In the example below it is being assigned to Card 1 Pushbutton input 1.

The annunciator unit can be set to sleep mode at any time using a remote mounting normally open maintained switch. When closed the LED’s and Audible Alarms are disabled to preserve power and prevent noise pollution.

Note: - All normal pushbutton functions are inhibited during sleep mode to ensure that the operator can view any alarms that occurred as soon as the unit is returned to its normal operational state.
Sleep Mode - Heartbeat

As the illumination, horns and pushbuttons are all disabled during sleep mode Eaton provide a periodic “heartbeat” pulse to all windows as an indication that the annunciator has been manually placed into sleep mode and is continuing to monitor as normal.

Some utility companies prefer to disable the “heartbeat” pulse and for 725B units shipped after September 8th 2008 this facility has been added as a configurable feature.

To disable the sleep mode “heartbeat” using the supplied 725B configuration software, (version 1.0.9. or above), the user will need to select the check box for “sleep mode without indication” under the general tab as shown below.

Once selected the user will need to select confirm settings and then the change can be saved to a local file or downloaded to the 725B using the supplied USB cable.

Once communication has been established between the laptop / PC and the annunciator the change can be downloaded using the tools – send settings menu.

Please note:-

“Sleep Without Indication” will only disable the “heartbeat” pulse i.e. all of the alarms will still be captured and individual channel (if fitted), or common alarm relays, will operate as normal whilst the unit is in sleep mode.

Once the annunciator unit is returned to the normal mode alarms will be displayed and horns / pushbuttons will operate as normal.
WR Relay Operation Whilst In Sleep Mode

On systems supplied after 1st February 2010 using configuration software version 2.0.5 or higher the common relays can be selected to operate during sleep mode or can be inhibited if required.

In the example shown below common relay 1 has been set to be disabled during sleep mode and common relays 2 – 4 will operate as normal.

In addition each common relay can be set to operate when the system test pushbutton is pressed or they can be inhibited. In the example below common relay 1 – 4 are all disabled when system test is pressed.

Internal Horn Options Whilst In Sleep Mode

On systems supplied after 1st February 2010 using configuration software version 2.0.5 or higher the internal horns can be selected to operate during sleep mode or can be inhibited if required.

In the example below both internal horns are shown as being disabled during sleep mode.
Inhibit

Alarm channels can be assigned to anyone of 8 Inhibit Groups (This is described in detail later in the manual).

Each inhibit group requires the use of a remotely mounted maintained switch which can be wired to any alarm card fitted with the pushbutton input option. Once the card and pushbutton input (1, 2 or 3) have been determined the Input needs to be assigned to the associated Inhibit Group using the drop-down menu. Please note if Pushbutton 1, 2 or 3 are greyed out they have already been assigned to other functions.

In the example below Group 1 Inhibit is assigned to Card 1 Pushbutton Input 3 and Pushbutton 1 and 2 are greyed out as they have been assigned to acknowledge and reset.

![Diagram of Inhibit Configuration]

If the Inhibit switch is selected to the closed position all of the alarms in the group will be “Inhibited” until the switch is returned to the off position.
Internal Horns Tab

2 x Internal Horns, Horn 1 & Horn 2, are supplied with each 725B Annunciator and these can be assigned to follow any of the Horn Groups.

In the example shown below:-

1. Horn 1 has been set to follow Horn Group 1
2. Horn 2 has been set to follow Horn Group 2.

Please note: This describes how to assign Horn 1 and 2 to follow any Group which has been set to Audible under the Group Operations Tab. However before the internal horns will function:-

1. Individual channels must be assigned to groups.
2. The Group Operation must be set to Audible on the assigned group.
3. The internal horns must be assigned to follow the correct group.

In more complex applications additional Groups are available and either of the Internal Horns can be set to follow any of these groups. To access the additional features the user must select the “View” menu followed by “Advanced View”. In the example shown below Horn 1 has been set to follow Horn Group 9 & 10 and Horn 2 has been set to follow Horn Group 11 & 12.
Test Internal Horn Volume
As Annunciators are used in areas with different levels of background noise the volume of each of the internal audibles can be adjusted using the slider bar.

In the example shown below Horn 1 has been set to 100% and Horn 2 has been set to 50%.

A test pushbutton is provided to the right of the slider bar to verify that the audible is working correctly.

Please note the function described below that allows Horn 1 or 2 to be set to pulse is overridden during volume testing to make adjustment easier, as soon as an alarm occurs the pulse feature is re-enabled.

Please note:-
The Annunciator must be connected via the USB serial link for this feature to function.

Horn 1 or 2 Pulse
As an option the user can interrupt the standard audible tone using a pulse generator. Either of the internal horns can have this feature enabled. In the example shown below Horn 2 has been set to “Pulse”

The user is able to update any field within the software but the changes will not take effect until the “Confirm Settings” control button is pressed using a left mouse click
**Auto Acknowledge Tab**

In applications that are not manned 100% of the time, noise pollution can be prevented using the Automatic Acknowledge feature.

This can be set using the Tick-Boxes in the “Auto Acknowledge Follows Horn Groups” field.

The “Delay” field allows the user to enter a time Delay in seconds.

<table>
<thead>
<tr>
<th>Auto Acknowledge Follows Horn Groups</th>
<th>Delay (Seconds)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 2 3 4 5 6 7 8</td>
<td>60</td>
</tr>
</tbody>
</table>

Once set the system will automatically acknowledge the alarms associated with the selective group after the preset time period has elapsed.

In more complex applications which exceed 8 Groups selecting the “View” menu followed by “Advanced View” allows all 32 Groups to be displayed as shown below.

Note: On systems supplied after 1st February 2010 using configuration software version 2.0.8 or higher the Auto Acknowledge operates the Acknowledge group 2 pushbutton, as this allows you the flexibility to pick which channels to auto acknowledge. To set a channel to auto acknowledge it must be put into Acknowledge Pushbutton group 2 using the pushbutton group tab on the individual channel.
**Auto Silence Tab**

In applications that are not manned 100% of the time, noise pollution can be prevented using the Automatic Silence feature.

The user can choose to automatically Silence any of the available Groups using the Tick-Boxes in the “Auto Silence Follows Horn Groups” field.

The “Delay” field allows the user to enter a time Delay in seconds.

| Delay [seconds] | 60 |

Once set the system will automatically Silence the alarms associated with the selective group after the preset time period has elapsed. Please note: This feature only Silences the audible alarm, the visual alarm will continue to operate in accordance with the selected ISA sequence.

In more complex applications which exceed 8 Groups selecting the “View” menu followed by “Advanced View” allows all 32 Groups to be displayed as shown below.

![Advanced View](image)

Note: On systems supplied after 1st February 2010 using configuration software version 2.0.8 or higher the Auto silence operates the silence group 2 pushbutton, as this allows you the flexibility to pick which channels to auto silence. To set a channel to auto silence it must be put into silence Pushbutton group 2 using the pushbutton group tab on the individual channel.
Group Operations Tab
Any channel within the Annunciator can be assigned to a single or multiple Groups and once assigned the “Group Operations Tab” allows the user to define the function of each group. A typical configuration example is shown below:-

1. Group 1 & 2 have been set as “Audible”
2. Group 3 & 4 have been set as “Alarm”
3. Group 8 has been set as “First Up”

A drop down menu is provided below each group, which allows the user to set the “Group Operation” to provide one of the functions detailed below:-

First-Up
When a 1st up alarm occurs within the associated group, the group signal will be active until the 1st alarm has been reset.

<table>
<thead>
<tr>
<th>ALARM STATE</th>
<th>GROUP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>1st Alarm to occur in a Group</td>
<td>Active</td>
</tr>
<tr>
<td>1st Alarm Reset</td>
<td>Off</td>
</tr>
</tbody>
</table>

Input
When a signal Input, on any alarm in the associated group, goes to the abnormal state the group signal will be active and the signal will remain active until the signal input returns to the non alarm state.

<table>
<thead>
<tr>
<th>ALARM STATE</th>
<th>GROUP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Input Abnormal</td>
<td>Active</td>
</tr>
<tr>
<td>Input Returns to Normal</td>
<td>Off</td>
</tr>
</tbody>
</table>

1. If the signal input of another alarm within the same group is in the abnormal state the group signal will remain active.

2. If 1 x channel within the group is in the abnormal state a 2nd alarm occurring within the same group will have no effect on the group signal as it will already be active.

3. When used with “WR” common relay cards reflash can be used to provide a momentary pulse each time a new alarm occurs within the same group.
**Alarm**

When any alarm in the associated group goes into alarm the group signal will be active and it will remain active until the signal input has returned to normal and the alarm has been cleared to the “off state” using the associated controlling pushbuttons.

<table>
<thead>
<tr>
<th>ALARM STATE</th>
<th>GROUP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Input Abnormal</td>
<td>Active</td>
</tr>
<tr>
<td>Input Returns to Normal</td>
<td>Active</td>
</tr>
<tr>
<td>Alarm Reset to the Off State</td>
<td>Off</td>
</tr>
</tbody>
</table>

1. If any other alarm, within the same group, is visible on the annunciator because its signal input is abnormal or it is waiting to be cleared by the operator the group signal will remain active.

2. If 1 x channel within the group is in the abnormal state a 2nd alarm occurring within the same group will have no effect on the group signal as it will already be active.

3. When used with “WR” common relay cards reflash can be used to provide a momentary pulse each time a new alarm occurs within the same group.

**Audible**

When any alarm in the associated group goes into alarm the group signal will be active and it will remain active until the audible signal is cleared using the mute or acknowledge pushbutton.

<table>
<thead>
<tr>
<th>ALARM STATE</th>
<th>GROUP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Input Abnormal</td>
<td>Active</td>
</tr>
<tr>
<td>Silence or Ack</td>
<td>Off</td>
</tr>
</tbody>
</table>

**Before Groups will function:-**

1. Individual channels must be assigned to groups.

2. The Group Operation must be set as detailed above.

3. The Group can be assigned to Common Relays as detailed under the WR* Tab

**Advanced View**

In more complex applications, which require more than the standard 8 Groups, selecting the “View” menu followed by “Advanced View” allows all 32 Groups to be displayed.
Comm’s Tab – Entry Level Comm’s

The communication tab provides access to settings using the drop menus shown below.

Communications settings are available as follows:

**Protocol:**
The following protocols can be selected using the drop down menu shown above.

1. No Communications required
2. RTK – AMS which allows the 725B to communicate with optional Eaton supplied Alarm Management Software
3. Modbus RTU Protocol for use with 3rd party devices

Please Note: - The Baud Rate, Parity and Timeout Settings are only displayed when the user selects the Advanced View using the View Menu.

**Baud Rate:**
The following baud rates can be selected using the drop down menu shown above.

1. 9,600
2. 19,200
3. 38,400

**Parity:**
The following parities can be selected using the drop menu shown above.

1. Odd
2. Even
3. None

**Timeout:**
If communication is not established within a specified period of time the user can use the watchdog facility to flag a loss of communication. As the time required establishing communication can vary depending on application and 3rd party device settings the user is able to enter a timeout time in ms from 1 to 65,536 ms
Comm’s Tab – Standard Comm’s
The communication tab provides access to settings for the following tabs.

**General Tab**

The General tab provides access to the general settings for each comm’s cards using the following options:

**Sync Pulse Source:**
Select the source of the global 1Hz sync pulse that is provided to the annunciator, the following are selectable from the drop down list.

1. **Internal** – Sync is generated by the comm’s card using the RTC
2. **External rising Edge** – Sync is generated by an external source with the rising edge used to sync the system.
3. **External Falling Edge** – Sync is generated by an external source with the falling edge used to sync the system.

**Sort Delay:**
When events are received from the alarm cards into the sort buffer, a sort delay can be set.

During this period the events are sorted into time/date order with the oldest event first in the buffer.

Once the period has expired the events are transferred into the port buffers. If set to 0 the sort delay is disabled.

The delay is selectable from 1 to 65,536 seconds.

Additional settings are available under advanced view. These are:
Enable Pushbutton Events:-
When time stamping is enabled it is possible to create events for the pushbutton activity. This can be enabled and disabled on the comm's card.

Enable Input Events:-
When time stamping is enabled it is possible to create events for the input activity. This can be enabled and disabled on the comm's card.

Enable Alarm Events:-
When time stamping is enabled it is possible to create events for the alarm activity. This can be enabled and disabled on the comm's card.

Enable Inhibit Events:-
When time stamping is enabled it is possible to create events for the inhibit activity. This can be enabled and disabled on the comm's card.

Enable Internal Events:-
When time stamping is enabled it is possible to create events for the internal diagnostic events. This can be enabled and disabled on the comm's card.

Advanced view options

Port Buffer Operation:-
The functionality of the multiple port buffers is also selectable with the following options:

1. Buffer Wait if other full – Wait if the other port buffers are full before passing events from the sort buffer. Otherwise the ports that are full will not receive the events passed from the sort buffer.

2. Buffer Wait if others full and active – Wait if the other port buffers are full and are still active before passing events from the sort buffer. Ports become inactive if the activity timeout has been reached otherwise the ports that are full will not receive the events passed from the sort buffer.

3. Buffer don’t wait if full – Don’t wait if the other port buffers are full before passing events from the sort buffer. This means if any buffers are full they won’t receive the events passed to the other port buffers that are not full.
Serial Port Tabs

Port 1 is the RJ11 port located on the XS485 or FC485.

Port 2 is the 9-way d-type connector on the comm’s card.

The following settings are available on Serial port unless otherwise stated:-

**Protocol:-**
The following protocols can be selected using the drop down menu shown above.

1. No Protocol
2. Configuration Slave – Port to be used to connect to the configuration software.
3. RTK AMS Slave – AMS which allows the 725B to communicate with optional Eaton supplied Indicium Software
4. Modbus RTU Slave Protocol for use with 3rd party devices
5. Modbus ASCII Slave Protocol for use with 3rd party devices
6. Wharton Protocol for use with the Wharton 4850/4860 Time Sync message
7. Modbus RTU Master Protocol for use with 3rd party devices
8. Modbus ASCII Master Protocol for use with 3rd party devices

**Note:** on Port 1 while the USB connector is plugged in the port is automatically configured as configuration slave. Once the cable is removed it reverts back to its original configuration.

**Baud Rate:-**
The following baud rates can be selected using the drop down menu shown above.

1. 9,600
2. 19,200
3. 38,400
Parity:-
The following parities can be selected using the drop menu shown above.
1. Odd
2. Even
3. None

Stop bits:-
The following stop bits can be selected using the drop menu shown above.
1. One Stop bit
2. Two Stop bits

Timeout:-
If communication is not established within a specified period of time the user can use the watchdog facility to flag a loss of communication. As the time required establishing communication can vary depending on application and 3rd party device settings the user is able to enter a timeout time in seconds from 1 to 65,536 sec’s

Node Address:-
Port node address is selectable from 0 – 255.

Additional settings are available under advanced view. These are:

Buffer Full Warning:-
If the buffer is becoming full the comm’s card can produce a warning event that will be recorded and displayed in Indicium as an event or attached to the watchdog to warn the user there may be an issue that is causing the buffer to fill up. The warning level is selectable from 10 – 90%.

Buffer Operation:-
For protocols that pass time stamped data, the port buffer can be enabled to work in certain ways, these are:
1. Disabled – If the Buffer is not used it can be disabled.
2. Keep Oldest Events – When the buffer gets full it doesn’t over write the oldest events.
3. Keep New Events – Overwrite the oldest events with new events when the buffer becomes full.

Activity Timeout:-
If communication is not established within a specified period of time then the port can become inactive. If the port has a buffer then this buffer can be closed if the port is inactive for a specified period. This allows other port buffer to continue taking events from the sort buffer without having to wait for the inactive port. The user is able to select an activity timeout in seconds from 1 to 65,536 sec before the port becomes inactive.
Ethernet Port Tabs

Port 3 is the RJ45 connector on the Enhanced comm’s card. Port 4 is the RJ45 connector on the comm’s card.

The following settings are available on the Ethernet dependant on protocol requested at time of order:-

1. No Protocol

**Port 3 Protocols**

2. IEC61850 Server Protocol for use with 3rd party devices
3. DNP3 Protocol for use with 3rd party devices

**Port 4 Protocols**

4. SNTP (Simple Network Time Protocol)

**IP Address:-**
The IP address of the ethernet port. This is in the format xx.xx.xx.xx.

**Subnet Mask:-**
The Subnet Mask of the ethernet port. This is in the format xx.xx.xx.xx.

**Gateway:-**
The Gateway of the ethernet port. This is in the format xx.xx.xx.xx.

**Buffer Full Warning:-**
If the buffer is becoming full the comm’s card can produce a warning event that will be recorded and displayed in Indicium as an event or attached to the watchdog to warn the user they may be an issue that is causing the buffer to fill up. The warning level is selectable from 10 – 90%.

**Buffer Operation:-**
For protocols that pass time stamped data, the port buffer can be enabled to work in certain ways, these are:

1. Disabled – If the Buffer is not used it can be disabled.
2. Keep Oldest Events – When the buffer gets full it doesn’t over write the oldest events.
3. Keep New Events – Overwrite the oldest events with new events when the buffer becomes full.
Activity Timeout:
If communication is not established within a specified period of time then the port can become inactive. If the port has a buffer then this buffer can be closed if the port in inactive for a specified period. This allows other port buffer to continue taking events from the sort buffer without having to wait for the inactive port. The user is able to select an activity timeout in seconds from 1 to 65,536 sec before the port becomes inactive.

Additional Protocol Setting
Each protocol may have settings which are specific to the protocol. These settings only appear when the protocol is selected:

Modbus RTU/ASCII Slave Protocols

<table>
<thead>
<tr>
<th>Modbus Slave Settings:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Register Offset</td>
<td>40001</td>
</tr>
<tr>
<td>Channel Status Offset</td>
<td>0</td>
</tr>
<tr>
<td>Data Source:</td>
<td>Register</td>
</tr>
</tbody>
</table>

Port Register Offset:-
The start register to access the port register data can be changed on the comm’s card by allowing the start register to be offset. This may be required for connection to 3rd party. This offset is selectable from 0 to 65,536 and is set to 40001 as default.

Channel Status Offset:-
The start register to access the channel status can be changed on the comm’s card by allowing the start register to be offset. This may be required for connection to 3rd party software which doesn’t support a start register of 0. This offset is selectable from 0 to 65,536 and is set to 0 as default.

NOTE: if both the port and channel status register offset overlap or are the same start value when the customer reads data it will default to contact status data.

Data Source:-
The data source format of the register can be set to the following:
Coil – Data for each address will be stored in coils, and can be read via Function 1 or written to via Function 15.
Register - Data for each address will be stored in its own register and can be read via Function 3 or written to via Function 6 or 16.
**Abnormal Register Mask:**
If the data source format is register a mask can be applied to mask out unused bits. In the example below only bit 0 is a valid bit, all other bits are ignored.

<table>
<thead>
<tr>
<th>Abnormal Register Mask</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

**Modbus RTU/ASCII Master Protocols**

<table>
<thead>
<tr>
<th>Modbus Master Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Tries:</td>
</tr>
<tr>
<td>Retry Time:</td>
</tr>
<tr>
<td>Poll Time:</td>
</tr>
<tr>
<td>Data Source:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Abnormal Register Mask</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

**Number of Tries:**
Number of times the master will try to communicate to the slave before the port will timeout.

**Retry Time:**
Time period in milliseconds the master will wait for a response from the slave before re-trying.

**Poll Time:**
Time in milliseconds to wait before sending next message after a valid response.

**Data Source:**
The data source format of the register can be set to the following:
Coil – Data for each address will be stored in coils, and will be read via Function 1 or written to via Function 15.
Register - Data for each address will be stored in its own register and can be read via Function 3 or written to via Function 6 or 16.

**Abnormal Register Mask:**
If the data source format is register a mask can be applied to mask out unused bits. In the example below only bit 0 is a valid bit, all other bits are ignored.
SNTP client

<table>
<thead>
<tr>
<th>Card 1</th>
<th>Port 1</th>
<th>Port 2</th>
<th>Port 3</th>
<th>Port 4</th>
<th>Mapping</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Protocol: SNTP Client</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General Details</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP Address:</td>
<td>10.100.100.100</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subnet Mask:</td>
<td>255.255.255.0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gateway:</td>
<td>10.88.100.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Server IP Address</td>
<td>0.0.0.0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poll Time:</td>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Timeout:</td>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Server IP address:-
The IP address of the SNTP Server that will provide the time to the Annunciator. This is in the format xx.xx.xx.xx.

Poll Time:-
Time in seconds to wait before sending a request to the Server.

Timeout :-
Time in seconds to wait for a response from the Server.

NOTE: As part of the SNTP standard the timeout period will be doubled after each timeout up to a maximum period of 2hrs. Once a valid response has been received this will reset back its initial value.

Mapping Tab

The mapping tab allows the port mapping data to be setup.

Mapped Port:-
The port which the mapping will be enabled on.

Import Port Mapping:-
Import mapping setting from the Mapping excel spreadsheet

Export Port Mapping:-
Export the current mapping setting to a excel spreadsheet.

Generate Spreadsheet:-
Generate a blank template spreadsheet for setting up the port mapping.
SECTION 7– CHANNEL SETTINGS

To configure individual channels the user must first select a window on the Annunciator graphic, using a left mouse click, to access additional menus.

Please Note:- It is possible to programme multiple channels using one of the following methods:-

Selective windows can be highlighted if the “Ctrl” Key on the keyboard is held down while you click on selective windows. Once the channels have been selected the user is able to select to navigate between tabs and select any feature. The background colour for all selectable field is White, however, this changes to Blue if the selective channels are not all set to the same function on the specific field. If the user wishes to proceed

Group of windows can be highlighted if the user clicks on the first window in the group and then holds down the “Shift Key” on the keyboard while you click on the last window in the group.

Channel Tab
The following features are available under the “Channel” Tab.
Alarm Legend
Each of the windows within the Annunciator needs to have a unique Legend to help the operator identify the alarm. The user types the alarm legend into the alarm legend field and drop-down menus allow selection of font, style and size to suit each application. Once the selection has been made a “Preview” button allows the user to review the appearance before saving the data. The preview pane must be closed before the user is able to continue configuring.

Once the data has been saved the user is able to Display the Legends on the Annunciator graphic for ease of configuration.

Show the Legends
To display Legends use the “View” Menu and select “Show Legends”.

Print the Legends
Legends can be printed for review using the “File” Menu and selecting “Print Legends”.
Export the Legends
Legends can be exported to a Microsoft Excel Template for future reference using the “File” Menu and selecting “Export Legends”.

Manual Inhibit
Each Channel can be manually inhibited within the software or a Channel can be assigned to an Inhibit Group. Once Channels have been assigned to a Group and a remote pushbutton input has been configured to operate the same Group they can be manually inhibited via a remote switch.

Inhibit Input
To manually inhibit a Channel the Inhibit input “Tick Box” must be checked as shown below.

Group 1 to Group 8
In the “Normal view” a single inhibit group is available and any channel can be assigned to Group 1 and a remote pushbutton input can be used to inhibit a group of alarms via a remote key switch.

In applications that require multiple inhibit groups the user must select the “View” Menu followed by “Advanced View” to access up to 8 inhibit groups.

Any Input can be assigned to any inhibit group so that a number of alarms can be manually inhibited via a number of remote key switch.

In the example below a Channel has been assigned to Inhibit Group 1 and 3.
Auto Shelving
On Systems supplied with the Sequence of Events Recording option a faulty alarm loop or loose cable can quickly flood the associated event buffers. Auto shelve allows the user to configure:-

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Count</td>
<td>The Maximum number of alarms the user believes will occur within a set period before the alarm count is considered abnormal</td>
</tr>
<tr>
<td>Count Period</td>
<td>The Time period in seconds</td>
</tr>
</tbody>
</table>

If the number of Input events exceeds the abnormal count within the count period the Input will be automatically shelved and a dated and timed message will be generated to inform the user that auto shelving has occurred on the specific channel. Events that occurred prior to the auto shelve will be stored in the relevant buffers in the normal way to aid fault finding and the alarm will automatically drop out of auto shelve when it has returned to normal operating patterns.

In the example below the user has indicated that 5 alarms occurring within 1200 seconds is considered abnormal.

Event Recording
Each channel can be set to allow data to be passed to the associated event buffers by enabling the Event Recording “Tick-Box”.

Colour
Colours are often used on Annunciator Systems to assist the operator in identify the type of Alarm. Traditionally Red is used for “Trip Alarms”, Amber for “Pre-Alarms”, White for “Process Alarms” and Green for “Status”. To aid channel navigation within the software each alarm window on the graphical display can be set to match the colour of the physical annunciator window. A drop down menu allows the user to select any of the six colours listed below and once the “Confirm Setting” control button is pressed using a left mouse click the associated graphic will be updated.
Input Tab
The following options are available under the “Input” Tab

Contact Type
A drop-down menu allows the user to assign the Contact Type for each Channel. In the example below a Channel is being configured to “Normally Open” (Close to Alarm). As an option each Channel can be set to Normally Closed (Open to Alarm).

Note: On system supplied prior to 30th July 2010 The input status is OR’d with the actual contact state. If the input is serial only please ensure the contact type is set to Normally Open and no customer wiring is made to the customer terminals located on the rear of the associated cell.

With serial inputs 0 = Input Normal and 1 = Input Abnormal

Delay Timers
Each channel is equipped with timers that allow the user to select:-

Abnormal Delay (ms)
This option will prevent the alarm from occurring unless it has been present for a pre-set period of time.

Normal Delay (ms)
This option will prevent the alarm from being Reset until the delay time has elapsed.

In the example shown below the Alarm must be present for a minimum of 50 ms before it is activated and must have returned to normal for the same period before it can be reset.
**Field Contact Voltage.**
Standard 725B Systems use 24VDC as a Field Contact Voltage.

As an option an external customer supplied power source can be used as a signal supply voltage.

**24V or 125V (AC or DC)**
On standard 725B Annunciators each channel can be hardware / software configured for use with 24V or 125V AC or DC signal voltages.

**48V or 250V (AC or DC)**
As an option, which must be specified at ordering phase, alternative alarm cards can be supplied allowing each channel to be hardware / software configured for use with 48V or 250V AC or DC signal voltages.

**Field Contact Voltage (V) selection**
Each channel is hardware & software configured to match the specified signal supply voltage at time of order.

To check or adjust this selection select the required voltage using the drop-down menu as shown below

```
<table>
<thead>
<tr>
<th>Channel</th>
<th>Input</th>
<th>Delay</th>
<th>Sequence</th>
<th>Pushbutton Groups</th>
<th>Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Type</td>
<td>Normally Open</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Abnormal Delay (ms)</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal Delay (ms)</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field Contact Voltage (V)</td>
<td>24VDC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contact Fault Reporting</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Please remember any changes to the field contact voltage must be hardware & software configured
Contact Fault Monitoring

If required the user can enable Contact Fault Reporting to indicate that the input device has deteriorated beyond set limits due to contact or wiring faults.

To access this feature the user must select the “View” Menu followed by “Advanced View” and the alarm trip fields shown below will be visible.

The following limits apply to each setting:

- Alarm Trip Low Hysteresis (%) = 10%
- Dwell Time (secs) = 256 seconds max
- Alarm Trip High Hysteresis (%) = 90%

These settings allow the user to define the trip points of each digital input and therefore any degradation in field wiring can be detected and a watchdog alarm can be generated. In the above example the Low trip is set to 30% and the high trip is set to 70% with a dwell time of 10 seconds.

Once a channel goes into alarm the dwell period is used to measure how long the switching voltage is present. If the circuit is healthy the switching voltage is typically shown by LINE A. If the circuit has a resistive value the switching voltage is typically shown by LINE B.

*Please note:-*
*Contact fault reporting only applies to signal inputs using DC voltages.*
**Remote and Local inputs**

On systems supplied after 30th July 2010 using configuration software version 2.0.9 or higher each individual input can be set to be driven from the local terminals or remotely via comms.

Note: The input will also take note of the contact type selection for both options. When set to remote:

- 0 = Input Normal and 1 = Input Abnormal when set to Normally Open
- 1 = Input Normal and 0 = Input Abnormal when set to normally closed

<table>
<thead>
<tr>
<th>Channel</th>
<th>Input</th>
<th>Relay</th>
<th>Sequence</th>
<th>Pushbutton Groups</th>
<th>Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Type</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Normally Open</td>
</tr>
<tr>
<td>Abnormal Delay (msec)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>10</td>
</tr>
<tr>
<td>Normal Delay (msec)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>10</td>
</tr>
<tr>
<td>Field Contact Voltage (V)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>24vDC</td>
</tr>
<tr>
<td>✔ Contact Fault Reporting</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>☐ Remote Input</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Relay Tab
If the System is provided with Repeat Relays on a per Channel basis the user will be able to access the fields listed under the “Relay Tab”. Please Note: On systems supplied with Dual Repeat Relays per channel both Relays are automatically set to the same state, (Coil State and Relay function)

If the field has been greyed out Repeat Relays have not been selected within the System set up software.

Coil Status
The Non-Alarm Coil State of each Relay can be set to Normally Energised or Normally De-Energised as required. In the example below a Channel is being set to Normally Energised.

<table>
<thead>
<tr>
<th>Channel</th>
<th>Input</th>
<th>Relay</th>
<th>Sequence</th>
<th>Pushbutton Groups</th>
<th>Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coil Status</td>
<td></td>
<td></td>
<td>Normally Energised</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Relay Function</td>
<td></td>
<td></td>
<td>Normally De-Energised</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Abnormal Delay (msec)</td>
<td></td>
<td></td>
<td></td>
<td>Abnormal Delay</td>
<td></td>
</tr>
<tr>
<td>Normal Delay (msec)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0</td>
</tr>
</tbody>
</table>

Relay Function
The function of each Relay can be set to follow the Input, follow the Alarm Logic or follow the Display. In the example shown below a Channel is being set to follow the Input.

<table>
<thead>
<tr>
<th>Channel</th>
<th>Input</th>
<th>Relay</th>
<th>Sequence</th>
<th>Pushbutton Groups</th>
<th>Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coil Status</td>
<td></td>
<td></td>
<td>Normally Energised</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Relay Function</td>
<td></td>
<td></td>
<td>Follow Input</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Abnormal Delay (msec)</td>
<td></td>
<td></td>
<td>Disabled</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal Delay (msec)</td>
<td></td>
<td></td>
<td></td>
<td>Follow Input</td>
<td></td>
</tr>
</tbody>
</table>

Abnormal Delay
Each Repeat Relay can be set to activate after a preset time period has elapsed.

In the example shown below a Relay has been set to 100mS and therefore the Relay will not change state until this time has elapsed.

<table>
<thead>
<tr>
<th>Channel</th>
<th>Input</th>
<th>Relay</th>
<th>Sequence</th>
<th>Pushbutton Groups</th>
<th>Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coil Status</td>
<td></td>
<td></td>
<td>Normally Energised</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Relay Function</td>
<td></td>
<td></td>
<td>Follow Input</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Abnormal Delay (msec)</td>
<td></td>
<td></td>
<td>100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal Delay (msec)</td>
<td></td>
<td></td>
<td></td>
<td>50</td>
<td></td>
</tr>
</tbody>
</table>
**Normal Delay**

Each Repeat Relay can be prevented from changing state unless the change in state has occurred for a set time period.

In the example shown below a Relay has been set to 50mS and therefore the Relay will not change state until this time has elapsed.
Alarm Sequences

Within the alarm annunciator market a common standard has been adopted by all key manufacturers and end users with regards to operational sequences. These standards are used worldwide to define the visual indication, audible alarm and the action the operator must take to control the annunciator.

The Instrument Society of America provide full details of each alarm sequence within ISA 18.1-1979 (R1992) and Eaton are fully compliant with the stated sequences. The most common sequences are detailed within this section of the manual.

To define a sequence the user can simply select any of the listed ISA sequences, as typically shown below.

In this example channel 5 is being set to ISA M sequence.

Pushbuttons

Six pushbuttons are provided on the annunciator unit to allow the user to be able to control any of the available sequences which can be set on a per channel basis.

Lamp Test – is used to test the LED assemblies by illuminating them in a steady state for as long as the pushbutton is pressed.
**Functional Test** – is used to simulate an input on all channels and therefore all windows and horn circuits will operate in accordance with the selected ISA sequence and additional pushbuttons will need to be pressed to step through the alarm sequence to return the unit to its normal state.

**Mute** – is used to silence the audible alarm whilst allowing the associated alarm window to continue to operate in accordance with the selected ISA sequence.

**Acknowledge** – is used to silence the alarm and change the state of the associated alarm window in accordance with the selected ISA sequence.

**Reset** – is used to return the alarm to the normal off state once the Input has returned to the normal condition.

**First Reset** – is used to reset the flash sequence on the first alarm to occur within a defined group of alarms. Once first reset has been pressed the next alarm to occur within the group will flash at the first up alarm rate.

**Audible Alarms**
Each channel within the annunciator can be set to operate either of the two integral audible alarms or they can be assigned to common relays configured as horn relays as required.
Additional Features

Automatic Reset
Once a channel has been acknowledged and its input has returned to normal the alarm can be set to automatically reset without the operator having to press the reset pushbutton.

Non Latch Sequence – (No Lock In)
Alarms can be set to non lock-in, which allows the alarm to automatically return to the non alarm state as soon as the signal input returns to normal.

Ringback Sequence
Ringback sequence is used to inform the operator both visually and audibly that an alarm condition has cleared and the channel can be reset to its normal off state. When a contact returns to normal the associated window will flash at approx ½ the speed of a normal alarm and the audible will sound. This identifies the specific alarm and informs the operator that the alarm can be reset to its normal off state.

First Up Sequences
When monitoring devices with interlinked functions such as a turbine or compressor it is often important to know the specific alarm that occurred first, as it will invariably result in cascade of secondary alarms. This allows the operator to focus on the root cause of failure and therefore limits the downtime and associated costs. This is achieved by having the first-up alarm flashing in a different manner compared to the subsequent alarms. Four different first-up sequences are available F0, F1, F2 and F3 as detailed below and in the following sequence tables.

F0 The standard mode adopted by Eaton, which indicates the first-up alarm by flashing at twice the rate of subsequent alarms.

F1 In this mode subsequent alarms appear in the acknowledged state, hence they do not flash. The audible device does not operate when subsequent alarms occur, unless still operating from the first alarm. The acknowledge pushbutton will reset the first-up indication.

F2 In this mode all subsequent alarms do not flash, they will however operate the audible device. The acknowledge pushbutton will reset the first-up indication.

F3 In this mode initial alarms appear with an intermittent flash rate and subsequent alarms flash at a steady rate. On acknowledge subsequent alarms revert to the steady on state and only the first alarm continues to flash at a slower rate.

Please note auto reset and non lock-in functions are not recommended when using first up sequences as the true sequence of events cannot be guaranteed.

The most common sequences are detailed below:-
ISA A – Automatic Reset – Lock In

Sequence Features

1. Acknowledge and test pushbuttons.
2. Alarm audible device
3. Lock In of momentary alarms until acknowledged
4. The Audible device is silenced and the flashing stops when acknowledged.
5. Automatic reset of acknowledged alarms when the process has returned to normal
6. Operational test
ISA A-1-2 – Automatic Reset – Silence Pushbutton Interlock

Sequence Features

1. Acknowledge, silence and test pushbuttons.
2. Alarm audible device
3. Lock In of momentary alarms until acknowledged
4. Silence pushbutton must be pressed before acknowledge
5. Silence stops the audible alarm only
6. The flashing stops when acknowledged.
7. Automatic reset of acknowledged alarms when the process has returned to normal
8. Operational test
ISA A-4 – Automatic Reset – Non Lock In

**Sequence Features**

1. Acknowledge, and test pushbuttons.
2. Alarm audible device
3. Non Lock In of momentary alarms
4. The audible device is silenced and the flashing stops when acknowledged.
5. Automatic reset of alarms when the process has returned to normal before or after acknowledge (Non Lock In)
6. Operational test
ISA A-4-5 – Automatic Reset – No Flashing

Sequence Features

1. Acknowledge, and test pushbuttons.
2. Alarm audible device
3. The visual alarm does not flash
4. Non Lock In of momentary alarms
5. The audible device is silenced when acknowledged.
6. Automatic reset of acknowledged alarms when the process has returned to normal
7. Operational test
ISA A-4-5-6 – Status

Sequence Features

1. Test pushbutton.
2. No alarm audible
3. The visual alarm does not flash
4. Non Lock In of momentary alarms
5. Automatic reset of alarms when the process has returned to normal before or after acknowledge (Non Lock In)
6. Operational test
Please Note:-

The drop down menu within the configuration software allows the user to select ISA Sequence A-4-5-6 to obtain Status Only indication however the audible alarm circuit will need to be disabled separately due to the large number of horn groups available within the system.

If the audible alarm sounds on a channel that has been set to ISA A-4-5-6 please check that the alarm is not part of a group which has been assigned to operate as an audible in the group operations tab.

In the example below Group 8 is being used as an audible group

**Group Tab**

This screen shot indicates that a channel / channels have been set to Group 8

<table>
<thead>
<tr>
<th>Channel</th>
<th>Input</th>
<th>Relay</th>
<th>Sequence</th>
<th>Distribution Groups</th>
<th>Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Group 8</td>
</tr>
</tbody>
</table>

**Group Operations Tab**

This screen shot indicates that Group 8 has been set to operate as an Audible alarm

To prevent the audible sounding on a status window the user should select a single status alarm window or group of status alarm windows and uncheck the tick box associated with a Group being used as an Audible in the example above this would be Group 8
ISA A-5 – Automatic Reset – No Flash

Sequence Features

1. Acknowledge and test pushbuttons.
2. Alarm audible device
3. The visual alarm does not flash
4. Lock In of momentary alarms until acknowledged
5. The Audible device is silenced when acknowledged.
6. Automatic reset of acknowledged alarms when the process has returned to normal
7. Operational test
ISA M – Manual Reset – Lock In

Sequence Features

1. Acknowledge, reset and test pushbuttons.
2. Alarm audible device
3. Lock In of momentary alarms until acknowledged
4. The Audible device is silenced and the flashing visual alarm stops when acknowledged.
5. Manual reset of acknowledged alarms when the process has returned to normal
6. Operational test
ISA M-1-2 – Manual Reset – Silence Pushbutton Interlock

Sequence Features

1. Acknowledge, reset and test pushbuttons.
2. Alarm audible device
3. Lock In of momentary alarms until acknowledged
4. Silence pushbutton must be pressed before acknowledge
5. Silence stops the audible alarm only
6. The flashing stops when acknowledged.
7. Manual reset of acknowledged alarms when the process has returned to normal
8. Operational test
ISA R – Ringback

Sequence Features

1. Acknowledge, reset and test pushbuttons.
2. Alarm audible device. (optional Ringback audible device)
3. Lock In of momentary alarms until acknowledged
4. The audible device is silenced and the flashing stops when acknowledged
5. Ringback visual ad audible indications when the process condition returns to normal
6. Manual reset of Ringback indications
7. Operational test
ISA F1A-1 – Automatic Reset First Up

Sequence Features

1. Acknowledge and test pushbuttons.
2. Alarm audible device
3. Lock In of momentary first alarm only, no lock in of momentary subsequent alarms
4. Flashing and audible indications for first alarm only, new subsequent alarms go to the acknowledge state.
5. First out indication is reset and the audible is silenced when acknowledged.
6. Automatic Reset of acknowledged alarm indications when the process returns to normal
7. Silence pushbutton can be used to silence the audible alarm only
ISA F2M-1 – Manual Reset First Up

SEQUENCE DIAGRAM

RESET WHILE NORMAL

FIRST TO ABNORMAL

SUBSEQUENT TO ABNORMAL

PROCESS
NORMAL
SEQUENCE
NORMAL
VISUAL
OFF
AUDIBLE
SILENT

SILENCE

ACKNOWLEDGE
(FIRST OUT RESET)

PROCESS
ABNORMAL OR NORMAL
SEQUENCE
ACKNOWLEDGED
VISUAL
ON
AUDIBLE
SILENT

ACKNOWLEDGE
(FIRST OUT RESET)

PROCESS
ABNORMAL OR NORMAL
SEQUENCE FIRST ALARM
VISUAL
FLASHING
AUDIBLE
AUDIBLE

SEQUENCE IS A F2M-1
(MANUAL RESET FIRST OUT WITH NO SUBSEQUENT ALARM FLASHING & SILENCED PUSHBUTTON)
**LINE** | **PROCESS CONDITION** | **PUSHBUTTON OPERATION** | **SEQUENCE STATE** | **VISUAL DISPLAY** | **ALARMS** | **DEVICE** | **REMARKS**
---|---|---|---|---|---|---|---
1 | NORMAL | NORMAL | OFF | SILENT |
2 | FIRST | ABNORMAL | FIRST ALARM | FLASHING | AUDIBLE | LOCK-IN |
3 | SUB. | ABNORMAL | SUB. ALARM | ON | AUDIBLE | LOCK-IN |
4 | FIRST | ABNORMAL OR NORMAL | ACKNOWLEDGE BEFORE SIL | TO LINE 7 | FIRST OUT | RESET |
5 | SUB. | ABNORMAL OR NORMAL | | | | |
6 | FIRST | ABNORMAL OR NORMAL | SILENCE | FIRST SILENCED | FLASHING | SILENT |
7 | SUB. | ABNORMAL OR NORMAL | SILENCE | ACKNOWLEDGE | ON | SILENT | MANUAL \*
RESET \* \* REQUIRED |
8 | FIRST | ABNORMAL OR NORMAL | ACKNOWLEDGE AFTER SILENCE | TO LINE 7 | FIRST OUT | RESET |
9 | NORMAL | RESET | NORMAL | OFF | SILENT | MANUAL RESET |

**SEQUENCE FEATURES**

1. Silence, acknowledge, reset and test pushbuttons
2. Alarm audible device
3. Lock-in of momentary alarms until acknowledged.
4. Option 1 – silence pushbutton to silence the alarm audible device while retaining the first out flashing indication
5. Flashing indication for first alarm only. New subsequent alarms have the same visual indication as acknowledged alarms.
6. First out indication is reset when acknowledged
7. Manual reset of acknowledged alarm indications after process conditions return to normal.
8. Operational test

**ISA F2A-1 – Automatic Reset First Up**
This sequence is the same as ISA F2M-1 with the exception that the alarms are automatically reset once the process has returned to normal.
ISA F3A – Automatic Reset First Up

SEQUENCE DIAGRAM

RETURN TO NORMAL

PROCESS NORMAL
SEQUENCE NORMAL
VISUAL OFF
AUDIBLE SILENT

ACKNOWLEDGE WHILE NORMAL

PROCESS ABNORMAL OR NORMAL
SEQUENCE SUBSEQUENT ALARM
VISUAL FAST FLASHING
AUDIBLE ON

FIRST OUT RESET WHILE ABNORMAL

ACKNOWLEDGE WHILE ABNORMAL

PROCESS ABNORMAL OR NORMAL
SEQUENCE FIRST ALARM
VISUAL INTERMITTENT FLASHING
AUDIBLE AUDIBLE

FIRST OUT RESET WHILE NORMAL

SEQUENCE ISA F3A
(AUTOMATIC RESET FIRST OUT WITHOUT FLASHING & RESET PUSHBUTTON)
### SEQUENCE TABLE

<table>
<thead>
<tr>
<th>LINE</th>
<th>PROCESS CONDITION</th>
<th>PUSHBUTTON OPERATION</th>
<th>SEQUENCE STATE</th>
<th>VISUAL DISPLAY</th>
<th>ALARM AUDIBLE DEVICE</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NORMAL</td>
<td>NORMAL</td>
<td>OFF</td>
<td>SILENT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>FIRST ABNORMAL</td>
<td>FIRST ALARM</td>
<td>INTERMITTENT FLASHING</td>
<td>AUDIBLE</td>
<td>LOCK-IN</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>SUB. ABNORMAL</td>
<td>SUB. ALARM</td>
<td>FAST FLASHING</td>
<td>AUDIBLE</td>
<td>LOCK-IN</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>FIRST ABNORMAL OR NORMAL</td>
<td>FIRST OUT RESET BEFORE ACKNOWLEDGE</td>
<td>TO LINE 3</td>
<td>FIRST OUT RESET</td>
<td>LOCK-IN</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>FIRST ABNORMAL OR NORMAL</td>
<td>ACKNOWLEDGE</td>
<td>FIRST ACKNOWLEDGED</td>
<td>SLOW FLASHING</td>
<td>SILENT</td>
<td>FIRST OUT RESET REQUIRED</td>
</tr>
<tr>
<td>6A</td>
<td>SUB. ABNORMAL</td>
<td>ACKNOWLEDGE</td>
<td>ON</td>
<td>SILENT</td>
<td>MAINTAINED ALARM</td>
<td></td>
</tr>
<tr>
<td>6B</td>
<td>SUB. NORMAL</td>
<td></td>
<td></td>
<td></td>
<td>MOMENTARY ALARM</td>
<td></td>
</tr>
<tr>
<td>7A</td>
<td>FIRST ABNORMAL</td>
<td>FIRST OUT RESET AFTER ACKNOWLEDGE</td>
<td>TO LINE 6A</td>
<td>FIRST OUT RESET</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7B</td>
<td>FIRST NORMAL</td>
<td></td>
<td>TO LINE 8</td>
<td>FIRST OUT RESET</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>NORMAL</td>
<td>NORMAL</td>
<td>OFF</td>
<td>SILENT</td>
<td>AUTOMATIC RESET</td>
<td></td>
</tr>
</tbody>
</table>

### SEQUENCE FEATURES

1. Silence, acknowledge, reset and test pushbuttons
2. Alarm audible device
3. Lock-in of momentary alarms until acknowledged.
4. Flashing indication for first alarm only. New subsequent alarms have the same visual indication as acknowledged alarms.
5. First out indication is reset when acknowledged
6. Manual reset of acknowledged alarm indications after process conditions return to normal.
7. Operational test
ISA F3A-3 – First Out Reset Interlock

This sequence is the same as F3A with the addition of First Reset Interlock which requires acknowledge to be pressed before First Reset will function.

ISA F3M – Manual Reset First Out

This sequence is the same as F3A with the addition of Manual Reset. All alarms must be manually reset once the process has returned to normal.

ISA F3M-1-2 – Manual Reset First Out with Silence Interlock

This sequence is the same as F3A with the addition of Silence Interlock and Manual Reset.

The Silence pushbutton must be operated before alarms can be acknowledged. The Silence pushbutton stops the Audible alarm only.

All alarms must be manually reset once the process has returned to normal.
Pushbutton Groups

Global Pushbutton Groups
Pushbutton functions are available on 725B annunciators which can be used to Test or control the alarms in accordance with ISA S18.1 Alarm Sequences.

In standard applications all channels are assigned to a single Pushbutton Group, (Group 1), however the user can enable or disable any of the functions on a per channel basis.

In the example shown below the Silence Pushbutton has been disabled for Channel 1.
**Multiple Pushbutton Groups**

In more complex applications each channel can be assigned to any of (8) Pushbutton Groups.

To access the additional groups the user must select the “View” menu followed by “Advanced View”. This will allow the 8 Groups to be displayed as shown below.

In the example below Lamp Test, Ack & Reset have been assigned to Pushbutton Group 2 for channels 9 to 14.

![Diagram of RTK device showing channel assignments](image)

**Please Note:-**

Pushbutton Group 1 is assigned to the Internal Pushbutton Module and any additional Pushbutton Groups will require the use of external pushbuttons.

On standard systems (6) Pushbutton Input terminals are available on the first Remote pushbutton card in the system for use with remote pushbuttons. If more than (6) remote inputs are required additional cards are supplied with pushbutton inputs, (6 per card).
**Alarm Groups**

Each channel within the annunciator can be linked to form part of a single or multiple Alarm Group (Group 1 to 8). Groups are typically used to provide summary alarm information that can be used by 3rd party devices (DCS / PLC / SCADA / Supervisor Consoles).

Channels can be assigned to a single or multiple Groups using a left “mouse” click on the associated field. In the example below a Channel has been assigned to Alarm Group 1 & 2.

![Alarm Group Assignment Example](image)

**Additional Groups**

In more complex applications the user is able to access additional menus which allow any Channel within the Annunciator to be linked to a maximum of 32 Groups.

To access the additional features the user must select the “View” menu followed by “Advanced View” to reveal the additional Groups as shown below.

![Advanced Group Assignment Example](image)

In the above example Channel 1 has been assigned to Group 1, 4, 8 and 21.

Once an Alarm Group has been defined the user can assign a single or multiple Relays to any of the Groups as detailed under the “WR1” Watchdog / Relay Tab Setting within this manual.
**Horn Groups**

Each Channel within the annunciator can be linked to form part of a single or multiple Horn Groups. Horn Groups are typically used to provide different tones for critical and non-critical alarms, but they can also be used when alarms need to be repeated to 3rd Party devices and the signal needs to be reset once the local alarm has been acknowledged.

Channels can be assigned to a single or multiple Groups using a left “mouse” click on the associated field. In the example below a Channel has been assigned to Group 1 & 2.

![Channel Assignment Example](image)

**Additional Horn Groups**

In more complex applications the user is able to access additional menus which allow any Channel within the Annunciator to be linked to a maximum of 32 Horn Groups.

To access the additional features the user must select the “View” menu followed by “Advanced View” to reveal the additional Horn Groups as shown below.

![Advanced View](image)

In the example shown above Channel 6 has been assigned to Horn Group 1, 3 & 5. Once a Horn Group has been defined the user can assign a single or multiple Relays to any of the Groups as detailed under the “WR1” Watchdog / Relay Tab Setting within this manual.

**Internal Horns:** Either of the 2 x Internal Horns can be set to operate from any Horn Group as required.
SECTION 8 - FACTORY DEFAULT SETTINGS

Global Systems Setting Default Settings

General Tab Default Settings

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plant Name</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>Tag Number</td>
<td>001</td>
</tr>
<tr>
<td>Serial Number</td>
<td>0</td>
</tr>
</tbody>
</table>

Event Recording Tab Default Settings

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequencer Events</td>
<td>Disabled</td>
</tr>
</tbody>
</table>

WR1 Tab Default Settings

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coil Status</td>
<td>Normally De-Energized</td>
</tr>
<tr>
<td></td>
<td>Disable in System Test</td>
</tr>
<tr>
<td></td>
<td>Disable in Sleep Mode</td>
</tr>
</tbody>
</table>

Local Pushbuttons Tab Default Settings

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Lamp Test Pushbutton Enabled</td>
</tr>
<tr>
<td></td>
<td>Acknowledge Pushbutton Enabled</td>
</tr>
<tr>
<td></td>
<td>Fossil Pushbutton Enabled</td>
</tr>
<tr>
<td></td>
<td>Silence Pushbutton Enabled</td>
</tr>
<tr>
<td></td>
<td>System Test Pushbutton Enabled</td>
</tr>
<tr>
<td></td>
<td>First-Up Pushbutton Enabled</td>
</tr>
</tbody>
</table>
Remote Pushbuttons Tab Default Settings

<table>
<thead>
<tr>
<th>Group 1</th>
<th>General</th>
<th>Event Recording</th>
<th>WR1</th>
<th>Local P&amp;Ts</th>
<th>Remote P&amp;Ts</th>
<th>Int. Horns</th>
<th>Auto Ack</th>
<th>Auto Silence</th>
<th>Group Types</th>
<th>Comm</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Lamp Test</td>
<td>Card 1, Pushbutton 1</td>
<td>Card 2, Pushbutton 1</td>
<td>System Test</td>
<td>Card 2, Pushbutton 1</td>
<td>First-Up Reset</td>
<td>Card 2, Pushbutton 3</td>
<td>Lamp Test &amp; Audible</td>
<td>Not Assigned</td>
<td></td>
</tr>
<tr>
<td>Acknowledge</td>
<td>Card 1, Pushbutton 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Not Assigned</td>
<td></td>
</tr>
<tr>
<td>Reset</td>
<td>Card 1, Pushbutton 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Not Assigned</td>
<td></td>
</tr>
<tr>
<td>Silence</td>
<td>Card 2, Pushbutton 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Not Assigned</td>
<td></td>
</tr>
<tr>
<td>Unattended</td>
<td>Not Assigned</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inhibit</td>
<td>Not Assigned</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Internal Horn Tab Default Settings

<table>
<thead>
<tr>
<th>Group 1</th>
<th>General</th>
<th>Event Recording</th>
<th>WR1</th>
<th>Local P&amp;Ts</th>
<th>Remote P&amp;Ts</th>
<th>Int. Horns</th>
<th>Auto Ack</th>
<th>Auto Silence</th>
<th>Group Types</th>
<th>Comm</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Horn 1 Follows Groups</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Horn 2 Follows Groups</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Horn 1 Volume</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Test Volume</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Horn 2 Volume</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Test Volume</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>100</td>
</tr>
<tr>
<td>Ham 1 Pulse</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ham 2 Pulse</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ham 1 Disabled During Sleep</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ham 2 Disabled During Sleep</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Auto Ack Tab Default Settings

<table>
<thead>
<tr>
<th>Group 1</th>
<th>General</th>
<th>Event Recording</th>
<th>WR1</th>
<th>Local P&amp;Ts</th>
<th>Remote P&amp;Ts</th>
<th>Int. Horns</th>
<th>Auto Ack</th>
<th>Auto Silence</th>
<th>Group Types</th>
<th>Comm</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Auto Acknowledge Follows Groups</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delay [seconds] 60</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Auto Silence Tab Default Settings

<table>
<thead>
<tr>
<th>Group 1</th>
<th>General</th>
<th>Event Recording</th>
<th>WR1</th>
<th>Local P&amp;Ts</th>
<th>Remote P&amp;Ts</th>
<th>Int. Horns</th>
<th>Auto Ack</th>
<th>Auto Silence</th>
<th>Group Types</th>
<th>Comm</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Auto Silence Follows Groups</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delay [seconds] 60</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Group Operations Tab Default Settings

<table>
<thead>
<tr>
<th>Group 1</th>
<th>Group 2</th>
<th>Group 3</th>
<th>Group 4</th>
<th>Group 5</th>
<th>Group 6</th>
<th>Group 7</th>
<th>Group 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audible</td>
<td>Audible</td>
<td>Alarm</td>
<td>Alarm</td>
<td>No Operation</td>
<td>No Operation</td>
<td>No Operation</td>
<td>First-Up</td>
</tr>
</tbody>
</table>
Comm’s Tab (Entry Level) Default Settings

Comm’s Tab (Standard) Default Settings

General Tab Default Settings

Port 1 Default Settings

Port 2 Default Settings
## Port 3 Default Settings

<table>
<thead>
<tr>
<th>Card 1</th>
<th>General</th>
<th>Port 1</th>
<th>Port 2</th>
<th>Port 3</th>
<th>Port 4</th>
<th>Mapping</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Protocol</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>None</td>
<td>□</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Port 4 Default Settings

<table>
<thead>
<tr>
<th>Card 1</th>
<th>General</th>
<th>Port 1</th>
<th>Port 2</th>
<th>Port 3</th>
<th>Port 4</th>
<th>Mapping</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Protocol</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>None</td>
<td>□</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Mapping Default Settings

<table>
<thead>
<tr>
<th>Card 1</th>
<th>General</th>
<th>Port 1</th>
<th>Port 2</th>
<th>Port 3</th>
<th>Port 4</th>
<th>Mapping</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Mapped Port:</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>□</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mapping Spreadsheet Loaded</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Import Port Mapping   Export Port Mapping   Generate Spreadsheet
Restore System Settings To Default

This software provides the user with a host of customer selectable options.

As users are able to select any number of features whilst navigating through the software they are able to return the software to factory default settings using the “Tools” and “Restore System Settings to Default” menu as shown below.

CAUTION
This setting will automatically convert the Systems Setting to factory default and therefore it should only be used with caution.
Individual Channel Default Settings

Channel Tab Default Settings

Input Tab Default Settings

Relay Tab Default Settings

Sequence Tab Default Settings
### Pushbutton Group Tab Default Settings

<table>
<thead>
<tr>
<th>Channel</th>
<th>Input</th>
<th>Relay</th>
<th>Sequence</th>
<th>Pushbutton Groups</th>
<th>Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Lamp Test Pushbuttons</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(1 \square 2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Reset Pushbuttons</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(1 \square 2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>System Test Pushbuttons</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(1 \square 2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Lamp Test &amp; Audible Pushbuttons</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(1 \square 2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Unattended Pushbuttons</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(1 \square 2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Acknowledge Pushbuttons</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(1 \square 2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Silence Pushbuttons</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(1 \square 2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>First Up Reset Pushbuttons</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(1 \square 2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Sleep Pushbuttons</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(1 \square 2)</td>
<td></td>
</tr>
</tbody>
</table>

### Groups Tab Default Settings

<table>
<thead>
<tr>
<th>Channel</th>
<th>Input</th>
<th>Relay</th>
<th>Sequence</th>
<th>Pushbutton Groups</th>
<th>Groups</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Groups</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(1 \square 2)</td>
<td>(3 \square 4 \square 5 \square 6 \square 7 \square 8)</td>
</tr>
</tbody>
</table>
**Restore Selected Channel to Default**
This software provides the user with a host of customer selectable options.

As users are able to select any number of features whilst navigating through the software they are able to return the software to factory default settings using the “Tools” and “Restore Selective Channels to Default” menu as shown below.

**CAUTION**
This setting will automatically convert the selected channel to factory default settings and therefore it should only be used with caution.
The given data is only intended as a product description and should not be regarded as a legal warranty of properties or guarantee. In the interest of further technical developments, we reserve the right to make design changes.